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INTRODUCTION TO PHOTOSHOP LAYERS 

Layers are one of the most important tools for working in Photoshop.  If you are not using layers, 
you are missing out on most of the creative power available in Photoshop.  

WHAT ARE LAYERS? 

Layers are a way of making Local or Selective adjustments to an image.  Layers are also a way 
of applying Global adjustments to the whole of an image non-destructively.   

Local or Selective adjustments are changes made to a part of the image only, whereas Global 
changes apply to the whole of the image.  Without layers, you are pretty much restricted to 
global changes to your image, apart from things like patching and cloning.  Selective 
adjustments are applied to the image via Layers, Masks and Opacity. 

Layers also allow us to control how adjustments are applied to the base image.  We will explain 
this later in the Blending Modes section. 

Layers are separate from the image and sit over the top of the base image (background).  
Imagine a clear sheet of plastic placed over your image containing instructions on how each 
pixel below is to be treated, in a similar way to a filter placed over the lens of your camera.   

Left: The Layers palette in Photoshop 

Layers contain sets of instructions that 
tell Photoshop how to alter the 
appearance of the underlying image 
information.   

Layers can be:  

A duplicate of the original layer – used 
to apply artistic filters or other 
treatments to the entire image (with 
reduced transparency and/or altered 
blending). 

An adjustment layer - a layer that is 
used for adjustments to parts of an 
image, (levels, curves, saturation etc.). 

Or a fill layer that is used to apply a 
pattern, colour, or texture to an image. 

 

A layer comprises three components:   

1. The layer itself containing the instructions (adjustment, filter etc.),  

2. A layer mask that determines where the adjustment is to be applied, and 

3. A blending mode that determine how the adjustment is to be applied. 

The blending mode includes a set of three options: 
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1. The blending mode,  

2. the transparency of the layer, and  

3. the Layer Styles. 

We will cover all of these in detail later. 

Tip:  Never, ever apply any adjustments to your base image.  Always apply adjustments with 
adjustment layers.  Why?  successive adjustments to the base image can quickly degrade the 
image data so that details are lost, and colours pushed out of gamut.  By using layers, you can 
see the cumulative effect of your adjustments and make fine adjustments accordingly to 
maintain your image quality and keep it in gamut. 

WHY ARE LAYERS USED? 

Layers are a non-destructive way of applying image adjustments as they do not affect the 
original pixel values of the background layer, unless the image is flattened. 

Layers can be adjusted repeatedly until (and if) the image is flattened (at which time the layer 
information is combined with the base image). 

Layers allow us to apply image adjustments selectively and reversibly to the base image by 
means of the layer mask,  blending modes and opacity. 

Layers can be built up in multiples to allow the widest possible range of creative input into the 
image. 

HOW DO WE APPLY LAYERS? 

Firstly, ensure you have the layers palette visible in Photoshop by going to “Window” on the 
menu bar and checking that the “Layers” palette is ticked.  This ensures that the Layers palette 
is visible on the right hand side toolbar. 

Layers are applied to an image in either of two ways: 

1. By going to the menu bar and selecting:  Layer> Duplicate layer, or Layer>New 
Adjustment layer, or Layer>New Fill layer. 

2. More simply by going to the Layers Palette and clicking on the half black and half 
white circle icon.  This opens a menu bar that lists options for fill and adjustment 
layers.  Alternatively, go to the Adjustments Palette and choose the type of layer 
you want to use. 
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Left:  The Layers Palette.   

To create a duplicate of the background (your base image), simply click on the layer shown 
inside the layers palette (a thumbnail with an eye symbol to the left and called “background”) 
and drag it to the square icon at the bottom with a folded over corner.   

This creates a duplicate of your base image, ready to apply a special or artistic filter.  When you 
create a new adjustment layer, you will choose the type of adjustment you want to make:  
Levels, Curves, Hue Saturation etc.   

By clicking on the type of layer you want, a menu box opens to allow you to make that 
adjustment.  Let’s say we are going to use Curves to alter the tone mapping of the image.  
When you select this adjustment the curves menu opens and you can make an adjustment, 
with the image being updated in real time to allow you to see the effect.  

Left:  The Adjustments Palette. 

Almost all of the types of adjustment layers are shown with icons in the Adjustments Palette. (but 
not the Solid colour Fill option, inexplicably – this has to be selected from the Layers Palette).  

To create a new adjustment layer, simply click on the icon (hover your mouse over to see a 
description) for the type of adjustment you want to make.  A new layer complete with a mask is 
created. 

For a description of the types of Adjustment layers, see below on page 5. 
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THE ELEMENTS OF THE LAYERS PALETTE 

Looking at the Layers Palette in the example below, you can see a series of layers sitting above 
the base or Background layer (the original image). 

Next to the adjustment type icon will be a white rectangle.  This is the Layer Mask.  On the right-
hand side of the layer mask is the name of the adjustment layer.  You can rename the layer by 
double clicking on the default name and typing in a name of your choice. 

On the left of the layer icon is an eye symbol.  When the eye is visible, the layer is turned on.  To 
turn it off, simply click on the eye and it disappears.  By turning the layer on and off you can see 
the effect of your adjustment.  

Left:  The Layers Palette in detail, with 
the Adjustment Palette above. 

The elements of the layers Palette are: 

The Blending Mode panel – here set to 
Normal. 

The Opacity Panel – here set to 100%. 

 

Adjustment layer – this is a Curves 
Adjustment layer. 

 

The Layer Mask – White is 100% applied, 
black makes the effect  transparent. 

 

 

 

A Layer Mask created from a selection 

 

The Image Layer – always called the 
Background layer  

 

Layer Visibility can be turned on and off by clicking on the eye icon at the left of the layer. 

To check and change the properties of an adjustment layer, click on the layer, and make sure 
the eye symbol is visible.  Now look at the top of the layers palette.  You will see directly under 
the layers tab a drop down box.  This is the Blending Mode options box.  By default, when you 
create a new layer, it is set to “Normal” blend mode.  By clicking on the downward facing 
arrow on the right-hand side of this box you will see all of the blending options to choose from.  
We will cover these shortly. 

At the right-hand side of the blending mode options box is the Opacity options box.  By default, 
a new layer is set to 100% opacity.  To change the opacity, click on the arrow at the right-hand 
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side of the box and either type in a new value, or drag the slider that appears to a new value.  
Remember that 0% opacity means it is transparent and 100% means the layer is totally opaque 
and the adjustment is at full strength. 

By right mouse clicking (or double clicking) on the layer you are working on, a new menu pops 
up with a number of options.  Click on the Blending Options to access the Layer Styles and 
Advanced Blending Modes menu box.  This is where blending based on luminosity ranges can 
be made.  More on this later. 

TYPES OF ADJUSTMENT LAYERS 

Photoshop has 16 standard adjustment layer types, found on the Adjustments Panel, plus the 
Colour Fill layer that can only be accessed from the bottom of the Layers Palette.   

The adjustment layers are, in order:   

1. Brightness/Contrast,  

2. Levels,  

3. Curves,  

4. Exposure, 

5. Vibrance,  

6. Hue/Saturation,  

7. Colour Balance,  

8. Black and White,  

9. Photo Filter,  

10. Channel Mixer,  

11. Colour Lookup,  

12. Invert,  

13. Posterise,  

14. Threshold,  

15. Selective Colour and  

16. Gradient map.  

Of these, the most often used are:  Brightness/Contrast, Levels, Curves, Hue/Saturation, Colour 
Balance and Black and White.  
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It should be noted that Curves adjustment layers offer much better control than 
Brightness/Contrast and Levels, so our recommendation is to use Curves adjustments for any 
brightness and contrast adjustments.  Using Curves allows you to alter the rate of change in 
luminosity as well as the amount of change.  You can’t do this with levels or Brightness/Contrast. 

The other types of adjustment layers will be used rarely or not at all, depending on what you are 
looking to achieve. 

MAKING ADJUSTMENTS USING THE ADJUSTMENT LAYERS 

Creating an adjustment layer does not make any change to the image below.  The new layer is 
created using the “Normal” Blend Mode, 100% Opacity and a mask filled with white. 

To make an adjustment, select the adjustment and in the Properties panel, carry out the 
adjustment using the tools provided. 

Left:  The Layers panel with a Curves adjustment selected.  The adjustment is carried out in the 
properties panel – here making an adjustment to increase contrast with an “S” curve.  

Each type of adjustment layer has different controls, depending on the function of the 
adjustment.  All adjustments made are updated in real time and are visible in the photo as you 
make them. 

To see the effect of any adjustment, click on the eye symbol at the left of the adjustment layer 
or the eye symbol at the bottom of the Properties Panel to turn it off and on. 
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FINE TUNING ADJUSTMENT LAYERS 

If you want to make a further adjustment to any adjustment layer, simply click on the 
adjustment layer icon to reopen the Properties Panel  and carry out the further adjustments.  This 
is repeatable as often as you want.   

Fine adjustments to the effect of any adjustment can be made by reducing the Opacity of the 
adjustment.  This can sometimes be easier than making a very minor adjustment to the 
properties of the adjustment. 

DUPLICATING THE BACKGROUND LAYER 

To apply so called “artistic” filters, either from Photoshop’s filters list, or via a plug-in like Topaz 
Studio, we make a copy of the Background layer and apply the filter to the copy.  This allows us 
to reduce Opacity of the filter, change the Blending mode and apply a mask, if needed. 

To make a duplicate of the background layer, click on the layer and drag it to the icon at the 
bottom of the Layers Palette that looks like a turned over page – see below.  A duplicate of the 
background is created. 

 

If you have made a duplicate layer and applied an “Artistic” filter, the duplicate layer does not 
automatically add a mask.  To add a layer mask to a layer, click on the rectangle icon with a 
black circle inside at the bottom of the layers Palette.  This will add a Mask filled with White to 
the selected layer, making the effect applied to the whole image. 

With the filter applied to the duplicate layer, and with a mask applied, you can fine tune the 
effect of this layer by adjusting the Opacity of the layer, changing the Blending mode, and 
painting onto the mask with either black or white. 

For applying “Artistic” filters, you now have the option of converting the layer to a “Smart 
Object”.  If you want to take advantage of this option you must first duplicate the background 
layer (as above) and then by right mouse clicking on the new layer select “Convert to Smart 
Object”  Before you apply the filter.  The filter then appears as a separate item below the 
background copy layer.  This can be re-edited by double clicking on the name of the filter and 
then making the adjustment required before clicking on OK.  Note that the layer mask now 
appears under the layer and the type of filter as a separate item below that again.   
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Left:  A duplicate of the background 
layer converted to a Smart Object.  A 
Topaz Studio filter has been applied to 
this layer.  The Mask now sits below the 
layer with the filter name underneath.   

To access the filter again, double click 
on the filter name (Topaz Studio), make 
the adjustments, and then click OK to 
process the changes. 

In this example, the Opacity of the filter 
is reduced to 62% and a mask applied 
to restrict the filter to parts of the image 
only. 

 

 

 

Tip:  When using an “Artistic” filter, always duplicate the background and apply the filter to the 
background copy layer.  Then reduce the transparency of this layer until the effect is reduced in 
strength sufficiently to be useful and not overpower your image. 

WORKING WITH THE LAYER MASK. 

By default, when you create a new Adjustment or fill layer, a mask is applied that allows the 
adjustment to apply to the whole of the image.  White sections of the mask mean that the 
adjustment is applied to that part of the image.  Black parts of the mask mean that adjustments 
do not apply to that part of the image.  “White reveals, Black conceals” is an easy way to 
remember what the mask does. 

So, if we want to be selective about where this adjustment is applied to the base image, we 
need to change the mask.  There are several ways to change the mask, but first the layer must 
be visible (eye open) and next you must click once on the layer mask icon (white rectangle) to 
select this as the area you are going to work on. 

Once the layer mask is selected you will see a second outline around the icon indicating this is 
where you are working. 
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The properties panel above the layers changes to the mask properties.  Here you can invert the 
mask, feather any selection applied, or reduce or increase the density of anything painted onto 
the mask.  Painting with black removes the effect completely from the area painted, however 
painting with a brush with low opacity will show as grey on the mask – indicating that the effect 
is partly hidden. 

 

Above:  The Paintbrush tool contextual menu under the main menu.  This menu changes for 
each different tool selected. 

Tip:  When you want to apply an adjustment layer to a small part of the image only, first convert 
the mask to black by clicking on the mask and then holding down the Control key and then the 
Delete key.  This converts the mask to black.  Alternatively, select black and choose the paint 

  

Left:  An adjustment layer with the 
mask selected (White rectangle 
around the mask icon).   

Far Left:  The Photoshop toolbar. 

The simplest and most effective way 
to change the mask is to paint on it 
with either black or white (these are 
the only options).  To paint on the 
mask, first go to the tools palette on 
the left of the desktop and select 
the paintbrush tool.  At the top of 
the workspace, under the main 
menu you will see a contextual 
menu that changes with each tool 
selected.  Make sure you have a 
soft edged brush selected from the 
options available (not shown here). 

Make sure that the foreground and 
background colours are set to black 
and white.  You will see a black 
square and a white square.  The 
one on top is the active one you will 
be using.  If you don’t have black 
and white visible, click on the small 
black and white icon directly above 
the colours to reset to the default 
colours, or simply type “D” to reset 
them.  To change from black to 
white and back again, click on the 
two-ended arrow above the 
foreground/background box (or 
type “X” to swap between them).  
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bucket, then click anywhere on the image to fill the mask with black (make the adjustment 
transparent).  Then choose a brush and select white to paint in the effect.  Simple ! 

To paint on the mask, first zoom in on your image and then paint on the image areas you want 
to include or exclude from the adjustment.  Remember to ensure the layer mask icon is still 
selected.  If your image suddenly changes to white or black as you paint, STOP, go to the history 
tab, and click on the last step before you started painting, or go to Edit>Udo on the main menu 
bar.  Then click on the Layer mask and start again. 

Tip:  To quickly change the size of the paintbrush, simply use the square bracket keys on the 
keyboard “[“ makes the brush smaller and “]” makes it larger.  If you only see a crosshair on your 
image, click on the “Caps Lock” key to change to the round cursor to easily see where you are 
working. 

If you accidently paint onto an area you don’t want, simply reverse the colour (“X”), and paint 
it back in or out.   This is completely reversible and re editable. 

A further way to modify the mask is to apply a Gradient Fill to the mask using the gradient fill 
tool, available from the main toolbar (It looks like a rectangle with a graduated fill.  From the 
contextual menu you have several options for the type of fill and direction.  Make sure you are 
working with Foreground to Background colours and then choose the type of gradient.  Apply 
the gradient by clicking and dragging across the image area in the direction you want the 
gradient to be applied.  This can be further refined with the paintbrush as above. 

Tip:  Another easy way to see where you are working on your image is to make the adjustment 
much stronger than you really want, then as you paint in or out on the mask, you can easily see 
where the adjustment is being applied.  When complete, simply double click on the adjustment 
layer icon and fine tune the adjustment.  Alternatively, reduce the opacity. 

Tip:  To make an adjustment layer apply only to the immediate layer below only, right mouse 
click on the layer and choose “create clipping mask”  from the drop down menu.  A small 
downward pointing arrow appears next to the layer thumbnail to show that it applies to the 
layer below only. 

APPLYING SELECTIONS TO MASKS 

An alternative way to modify the layer mask is to make a selection on the image before you 
create the adjustment layer.  The selection is automatically applied to the layer mask when the 
new layer is created.  If you have already created the new adjustment layer you can delete 
the existing layer mask by right mouse clicking on the layer mask and choosing “Delete Layer 
Mask.”  Next make your selection (remembering to feather as required) and then, making sure 
the correct layer is active (highlighted) on the layers palette, then click on the “Create Layer 
Mask” icon on the bottom of the layers palette (this looks like a white circle inside a rectangle).  
The selected area becomes the white part of the mask.  You can then modify the mask with the 
paintbrush tool as above. 

Layer masks can be worked over repeatedly with the paintbrush and/or gradient fill tools.  This 
process is completely reversible and non-destructive.  Layer masks can be further refined by 
using the Levels tools, curves tools or the blur filter.  Refer to the other tutorials on this site for 
more information. 

Making selections is covered in depth in a separate document “ Making Selections in 
Photoshop” 

WORKING WITH THE BLEND MODES 

The following blend modes are available from the drop down menu at the top of the layers 
palette.  These are divided into six groups:  The Independent Modes, The Darkening Modes, The 
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Lightening Modes, The Light or Contrast Modes, The invert, or Comparative Modes and the HSL 
Modes. 

The following information is extracted from the Help menu in Photoshop: 

Independent Modes: 

Normal:  Edits or paints each pixel to make it the result colour. This is the default mode.  

Dissolve:  Edits or paints each pixel to make it the result colour. However, the result colour is a 
random replacement of the pixels with the base colour or the blend colour, depending on the 
opacity at any pixel location.  

Darken Modes: 

Darken:  Looks at the colour information in each channel and selects the base or blend 
colour—whichever is darker—as the result colour. Pixels lighter than the blend colour are 
replaced, and pixels darker than the blend colour do not change. 

Multiply:  Looks at the colour information in each channel and multiplies the base colour by the 
blend colour. The result colour is always a darker colour. Multiplying any colour with black 
produces black. Multiplying any colour with white leaves the colour unchanged. 

Colour Burn: Looks at the colour information in each channel and darkens the base colour to 
reflect the blend colour by increasing the contrast. Blending with white produces no change.  

Linear Burn:  Looks at the colour information in each channel and darkens the base colour to 
reflect the blend colour by decreasing the brightness. Blending with white produces no change.  

Darker Colour:  Compares the total of all channel values for the blend and base colour and 
displays the lower value colour. Darker Colour does not produce a third colour, which can result 
from the Darken blend, because it chooses the lowest channel values from both the base and 
the blend colour to create the result colour.  

Lighten modes: 

Lighten:  Looks at the colour information in each channel and selects the base or blend 
colour—whichever is lighter—as the result colour. Pixels darker than the blend colour are 
replaced, and pixels lighter than the blend colour do not change.  

Screen:  Looks at each channel’s colour information and multiplies the inverse of the blend and 
base colours. The result colour is always a lighter colour. Screening with black leaves the colour 
unchanged. Screening with white produces white. The effect is similar to projecting multiple 
photographic slides on top of each other.  

Colour Dodge:  Looks at the colour information in each channel and brightens the base colour 
to reflect the blend colour by decreasing the contrast. Blending with black produces no 
change.  

Linear Dodge (Add):  Looks at the colour information in each channel and brightens the base 
colour to reflect the blend colour by increasing the brightness. Blending with black produces no 
change.  

Lighter Colour:  Compares the total of all channel values for the blend and base colour and 
displays the higher value colour. Lighter Colour does not produce a third colour, which can 
result from the Lighten blend, because it chooses the highest channel values from both the 
base and blend colour to create the resulting colour.  
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Light or Contrast Modes: 

Overlay:  Multiplies or screens the colours, depending on the base colour. Patterns or colours 
overlay the existing pixels while preserving the highlights and shadows of the base colour. The 
base colour is not replaced but mixed with the blend colour to reflect the lightness or darkness 
of the original colour.  

Soft Light:  Darkens or lightens the colours, depending on the blend colour. The effect is similar to 
shining a diffused spotlight on the image. If the blend colour (light source) is lighter than 50% 
grey, the image is lightened as if it were dodged. If the blend colour is darker than 50% grey, the 
image is darkened as if it were burned in. Painting with pure black or white produces a distinctly 
darker or lighter area but does not result in pure black or white.  

Hard Light:  Multiplies or screens the colours, depending on the blend colour. The effect is similar 
to shining a harsh spotlight on the image. If the blend colour (light source) is lighter than 50% 
grey, the image is lightened, as if it were screened. This is useful for adding highlights to an 
image. If the blend colour is darker than 50% grey, the image is darkened, as if it were 
multiplied. This is useful for adding shadows to an image. Painting with pure black or white results 
in pure black or white.  

Vivid Light:  Burns or dodges the colours by increasing or decreasing the contrast, depending on 
the blend colour. If the blend colour (light source) is lighter than 50% grey, the image is 
lightened by decreasing the contrast. If the blend colour is darker than 50% grey, the image is 
darkened by increasing the contrast.  

Linear Light:  Burns or dodges the colours by decreasing or increasing the brightness, depending 
on the blend colour. If the blend colour (light source) is lighter than 50% grey, the image is 
lightened by increasing the brightness. If the blend colour is darker than 50% grey, the image is 
darkened by decreasing the brightness.  

Pin Light:  Replaces the colours, depending on the blend colour. If the blend colour (light 
source) is lighter than 50% grey, pixels darker than the blend colour are replaced, and pixels 
lighter than the blend colour do not change. If the blend colour is darker than 50% grey, pixels 
lighter than the blend colour are replaced, and pixels darker than the blend colour do not 
change. This is useful for adding special effects to an image.  

Hard Mix:  Adds the red, green, and blue channel values of the blend colour to the RGB values 
of the base colour. If the resulting sum for a channel is 255 or greater, it receives a value of 255; 
if less than 255, a value of 0. Therefore, all blended pixels have red, green, and blue channel 
values of either 0 or 255. This changes all pixels to primary colours: red, green, blue, cyan, yellow, 
magenta, white, or black.  

Invert or Comparative Modes: 

Difference:  Looks at the colour information in each channel and subtracts either the blend 
colour from the base colour or the base colour from the blend colour, depending on which has 
the greater brightness value. Blending with white inverts the base colour values; blending with 
black produces no change.  

Exclusion:  Creates an effect similar to but lower in contrast than the Difference mode. Blending 
with white inverts the base colour values. Blending with black produces no change. 

HSL Modes: 

Hue:  Creates a result colour with the luminance and saturation of the base colour and the hue 
of the blend colour.  
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Saturation:  Creates a result colour with the luminance and hue of the base colour and the 
saturation of the blend colour. Painting with this mode in an area with no (0) saturation (grey) 
causes no change.  

Colour:  Creates a result colour with the luminance of the base colour and the hue and 
saturation of the blend colour. This preserves the grey levels in the image and is useful for 
colouring monochrome images and for tinting colour images.  

Luminosity:  Creates a result colour with the hue and saturation of the base colour and the 
luminance of the blend colour. This mode creates the inverse effect of Colour mode.  

Listing all these blending modes may seem a little over the top, however in practice you only 
really need to worry about a few that are the most often used. 

Typically, the most commonly used blend modes are:  Normal, Lighten, Darken, Overlay, Soft 
Light, colour, and Luminosity 

Tip: If you are using adjustment layers for levels, curves or brightness /contrast adjustments, use 
“Luminosity” as the blend mode to avoid introducing colour shifts to your image.  

WORKING WITH OPACITY (TRANSPARENCY) 

Adjusting the opacity or transparency of a layer is a lot simpler to follow than the various blend 
modes and is often the most commonly used of the blending options.   

If you are using “artistic” filters – and by that, I mean any one of the myriads of special effects 
found under the “Filter” menu, you should be reducing the transparency of these filters as a 
matter of course.  The filters available in Photoshop are interesting and can be effective in 
realising your vision, but they are overpowering if used in an undiluted form.   

Tip:  When working with adjustment layers I often make the adjustment greater than I really 
want and then fine tune it with the transparency as it is adjustable over a wide range (0- -100%).  

To adjust the transparency, simply click on the Opacity arrow next to the existing value (default 
100%).  A slider appears which you can drag with your mouse with the effect visible as a live 
preview.  Alternatively, you can highlight the existing value and type in a new value between 0 
and 100%. 
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WORKING WITH LAYER STYLES 

 

Above:  The “Layer Styles” options are a little less obvious than the transparency and blend 
modes however, here is where you will find the special treatments you can apply to layers such 
as:  Bevel and Emboss, Drop Shadows etc.  these are useful for text, but the main interest to us is 
in the “Advanced Blending Options.”  To access these options, right mouse click on the layer of 
your choice (not on the thumbnail or layer name) and click on Blending Options.  A new menu 
box opens with the General and Advanced Blending box open.    

Here you can select the blending of the layer based on the luminosity values of the layer, 
without the need to make a mask, which can be a real time saver for some photographs. 

To access these controls, ignore the top part of the menu box and go to the bottom section 
labelled “Blend If.”  By default, the mode is set to “Grey.”  Leave this as is and go straight to the 
sliders beneath the box (You can blend by colour channel, but that is beyond our scope here).   

The top slider called “This Layer” controls which brightness values from the current adjustment 
layer will be blended with the layers below.  The bottom slider labelled “Underlying Layer” 
controls which brightness values from the layers below will be blended into the final “mix.” 



15 
 

 

Above:  A composite image comprising a background layer (trees) and a texture layer above.  
The two layers have been blended using the Blend If Layer Style as shown below. 

 

Above:  The Blend If settings applied to the texture layer.  The tonal range for the underlaying 
layer has been modified to exclude blending the darker tones – the trees silhouette.  The dark 
tones slider has been split to feather the transition by holding down the Alt key and splitting the 
slider.  A greater distance apart means more feathering.  No masks are required for this effect. 

Tip:  Using the blending options can save a lot of time in working on the mask if you are working 
on very dark or very light areas that are difficult to select. 
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AND FINALLY 

Working with layers, masks, blend modes and opacity in Photoshop provides access to the 
awesome processing power of Photoshop.  Mastering these essential skills will open up a whole 
new range of creative possibilities. 

Everything else we do in Photoshop is based around these skills and there are several more tools 
that make working with layers even more powerful and more creative.  Master the basics of 
layers and you will have access to the most important part of Photoshop.  

As all of these techniques are non-destructive, you can experiment as much as you like without 
risking damaging your base image. 
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